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1 Introduction 

This guidance note details a potential process for zoning land. However, it is recognised that the exact 

approach is likely to vary on a case-by-case basis. This document focuses on the process; the 

‘Zoning: Introductory Guidance Note’ should be referred to for advice regarding the categorisation of 

zones. 

2 The Process 

An overview of the proposed process is provided below: 

 

 

It is recommended that you do not use master copies when following the process to avoid loss of 

data. 

2.1 Create Layers for Zones 1 to 5 

To create the layers for zones 1 to 5: 

 Use new shapefile layers for each zone category; 

 Create the layers as polygons and set British National Grid as the CRS; 

 The ‘Attribute Table’ for each zone includes the Headers: 

Apply styles

Clean attribute table

Fix overlapping layers

Manual selection process

Utilise non-domestic rates registers

Utilise footfall/vehicle movement data

Clean combined dataset

Combine remaining datasets

Separate layers by attrribute

Migrate existing layers

Create and populate zone 6

Create layers for zones 1 to 5



o Org; 

o Land_Type; 

o Department; 

o Zone; 

o H_and_S; and 

o Reason (if ‘H_&_S’ is marked ‘Y’). 

Note: It is important to set up the fields at this stage to ensure attribute data is not lost later in the 

process. Remember that attributes are lost if copying and pasting between layers that do not have the 

same field names.   

2.2 Create and Populate Zone 6 

Zone 6 is specifically used for roads over 40mph and operational railway land more than 100m from 

the station platform.  

2.2.1 Roads Over 40mph 

If the dataset containing your road responsibilities also contains accurate and comprehensive speed 

limit data, you should consider selecting all of your roads with a speed limit greater than 40mph using 

a simple expression to assign them Zone 6. Checks will be required to ensure roads have been zoned 

correctly. 

Caution is required where two separately sourced layers are used for road responsibility and speed 

limits. Figure 1 demonstrates some of the potential issues caused by combining OS Open Data with 

Local Authority data: 

  

Figure 1: Issues caused by over-sail (left image) and an undivided polygon (right image) 

The left image in Figure 1 illustrates how the OS Open Data road slightly over-sails the split in the 

Local Authority polygon, resulting in the road marked with an arrow being incorrectly selected. 

The right image above illustrates how the westward bound road has been incorrectly selected due to 

there not being a split in the Local Authority polygon.  The arrow indicates where a split could be 

added to fix this error. 

If the two separate datasets do not closely match, you can either make amendments to the datasets, 

or you can revert to a manual process. 

2.2.2 Removing Zone 6 From Other Datasets 

It is important to remove Zone 6 from the other datasets before using them (geoprocessing 

‘Difference’ tool – see Technical Guidance Note 1; section 4.2). This is to avoid having zones that 

overlap. 
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2.3 Migrate Existing Layers 

If you have an existing layer in which all of the features relate to a single zone, you should copy and 

paste the entire layer into the relevant zone. For example, you may have a layer that only contains 

cemeteries, and it may be that you want all cemeteries to be categorised as Zone 4. In this case, you 

would: 

 ‘SelectAll’ of the cemeteries; 

 Copy them (Control+C); 

 Left click on ‘Zone 4’ and make the layer editable; 

 Paste (Control+V) into ‘Zone 4’ and save changes; and 

 Remove the cemeteries layer from the workspace. 

Please note the above example is purely for illustrative purposes, it is not a suggestion that all 

cemeteries are Zone 4. 

2.4 Separating Layers by Attribute 

Certain attributes within an existing layer may relate to specific zones. In these cases, you can: 

 Use ‘Select feature using an expression’  to select the relevant feature; 

 Cut (Control+X) the selected features from the layer; 

 Make the relevant zone editable and paste (Control+V) in the features; and 

 Save the changes. 

2.5 Combine Remaining Datasets 

Once you have utilised all of the attributes of your existing datasets, it is recommended that you 

combine all of these datasets into a single layer. This will allow you to zone areas more quickly. 

You can combine shapefiles via Vector Data > Data Management > Merge Shapefiles to One. 

The exact name of the tool does vary between versions of QGIS, but the symbol  and location 

under ‘Data Management’ remains the same. 

2.6 Clean Combined Dataset 

Before using the combined dataset make sure any already zoned areas are removed to avoid creating 

overlapping zones. To do this, use the geoprocessing tool ‘Difference’ (see Technical Guidance Note 

1; section 4.2) for each of the six zones. 

2.7 Utilise Footfall/Vehicle Movement Data 

Consideration should be given to utilising any existing footfall and vehicle movement data that may be 

available to help assign minimum Zone categories to areas. 

2.8 Utilise of Non-Domestic Rates Registers 

Zones categories should also take account of the number of Potential Litter Sources (PLS). The zone 

categories associated with numbers of PLS are in Table 1. 

 

 

 



Table 1: Zone Categories Based on the Number of Potential Litter Sources 

Category No. of Potential Litter Sources 

1 20 or more high risk potential litter sources 

2 15-19 high risk potential litter sources 

3 10-14 high risk potential litter sources 

4 5-9 high ris potential litter sources 

5 <5 high risk potential litter sources 

6 N/A 

 

The type of PLS are divided into two categories - high risk and moderate-low risk, where 4 moderate-

low risk PLS equate to 1 high risk PLS. Definitions of high and moderate-low risk are stated in Tables 

2 and 3 of the  ‘Zoning: Introductory Guidance’. 

The majority of the PLS sites may be captured by the non-domestic rates register. It is therefore 

envisaged that a heatmap could be generated and used as a quick and clear visual aid during the 

zoning process. 

2.9 Manual Selection Process 

A number of approaches could be used for a non-attribute driven selection process. The approach 

below is consistent with earlier parts of the process and involves minimal steps: 

 Make the combined layer editable; 

 Use the  ‘Select feature by freehand’ tool ;  

 Select the areas you want to zone (if you select an area accidentally, hold down Control and 

drag over the area to remove from selection); 

 Cut (Control+X) the selection; 

 Make the target zone layer editable and paste (Control+V); 

 Save changes to the zone; and 

 Continue this process until all of your combined layer has been reallocated to a zone. 

2.10 Fix Overlapping Layers 

It is important for both the zoning and dividing process that there are no overlapping zoned layers. The 

exception to this is where the overlaps don’t occupy the same physical space (e.g. bridges, 

underpasses, etc.). 

The ‘Topology Checker’ in QGIS is extremely sensitive and does not allow the user to set a tolerance.  

Therefore, if used to identify overlaps between large datasets, the ‘Topology Checker’ is likely to 

produce a huge list of results, many of which will be so small as to be insignificant. 

It is therefore recommended that the following process is used to identify and remove overlapping 

zoned layers: 

 Use the ‘Intersect…’ tool (Vector > Geoprocessing Tools > Intersect…) to create new layers 

where the zones overlap; 



Zoning: Technical Guidance Note 3: The Zoning Process 
 

7 

 
 

 Repeat the above step for all zone combinations.  In other words, the following layers should 

be produced: 

o Zones 1 & 2 

o Zones 1 & 3 

o Zones 1 & 4 

o Zones 1 & 5 

o Zones 1 & 6 

o Zones 2 & 3 

o Zones 2 & 4 

o Zones 2 & 5 

o Zones 2 & 6 

o Zones 3 & 4 

o Zones 3 & 5 

o Zones 3 & 6 

o Zones 4 & 5 

o Zones 4 & 6 

o Zones 5 & 6 

For all zone combinations the following steps should be taken: 

 Left click on the newly created layer in the ‘Map Legend’ and click on the ‘Open Attribute 

Table’ button   in the top toolbar. 

 Click on the ‘Open Field Calculator’ button   in the ‘Attribute Table’ toolbar and populate as 

illustrated below: 



 

 

 Click twice on the newly created field heading (‘Area’) in the ‘Attribute Table’.  This will sort the 

features by area size (largest to smallest). 

 
 

 Starting at the top of the table (i.e. the largest overlap), left click on the row number to select 

the row.  Then right click anywhere on the row and click on ‘Zoom to feature’. 
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 This will centre the ‘Map View’ on the selected feature (highlighted yellow). 

 
 

 At this point the measurement tool  can be used to further check the significance of the 

overlap and a judgement can be made as to whether adjustments are necessary. 

 Once the overlap has been fixed (see below), repeat the process for all features where the 

‘Area’ is greater than 1m2 and repeat for all of the zone combinations created by the intersect 

tool. 

 

To then fix the layers that overlap: 

 Make the overlapping layers visible: 



 
 

 Turn off the intersects layer: 

 
 

 Make the layer that is highest in the ‘Map Legend’ transparent (in this example 50%) and 

change the colours of the layers if there is insufficient contrast: 

 
 

 Establish which zones boundary is incorrect (i.e. which layer needs amending); 

 Go to snapping options (Settings > Snapping Options…) and set the snapping tolerances for 

the two layers; 

 Make the layer you wish to amend editable ; 

 If the feature sits entirely within the boundary of the other layer delete the incorrect polygon 

(this was the case with this example): 
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 If the overlapping polygon is part of a larger polygon that you wish to keep, you will want to 

amend the boundary to remove the area of overlap.  One way of achieving this would be to: 

o Click on the ‘Node Tool’ ; 

o Drag the offending nodes near to the boundary of the other layer (they should snap 

back to the boundary line); 

o You may need to create new nodes to accurately amend the boundary.  New nodes 

are created by double clicking on the segment whilst the ‘Node Tool’ is active; 

o Once you are happy with the amendments, save the layer and turn off editing . 

 

 

2.11 Clean Attribute Table 

It is important that the ‘Attribute Table’ for each zone layer is cleaned so that only the exact headers 

detailed below are included (see Table 2): 

 Organisation responsible for the identified land (Header: Org); 

 Department (Header: Department); 

 Zone number classification (Header: Zone); 

 Health & safety or access issues present which prevent monitoring of the site (Header: 

H_and_S and populate with ‘Y’); 

 Named health & safety or access reason (Header: Reason). 

 

Table 2: Example Attribute Table 

 

 

 



It may be that some of the above attributes have been assigned prior to the zoning process, with the 

exception of ‘Zone’. 

To assign a value to the zone field of your layers: 

 Left click on zone layer in the ‘Map Legend’; 

 Click on ‘Attribute Table’ button  on top toolbar; 

 Make the layer editable ; 

 Select ‘Zone’ from the pulldown menu;   

 Type the zone number of the layer in the box; 

 Click ‘Update All’; 

 Save the changes and make uneditable  and 

 
 Repeat for all layers. 

 

2.12 Apply Styles 

The following styles should be attributed to each zone: 

Table 3: Style Guidance for Zone Layers 

Zone Category Colour Hex Number RGB Code 

1  #8c510a 140, 81, 10 

2  #d8b365 216, 179, 101 

3  #f6e8c3 246, 232, 195 

4  #c7eae5 199, 234, 229 

5  #5ab4ac 90, 180, 172 

6  #01665e 1, 102, 94 

 

 



Zoning: Technical Guidance Note 3: The Zoning Process 
 

13 

 

 

 


